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nComputer—Hardware Components

One Touch Learn )
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Lets Do It
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1 a
6. a.
B. 1
1. output device
4. input devices

Hw N

S N

a
a.
F F 3. F 4. F 5T

Storage devices 3. 3D camera

uoN

radio frequency

Motherboard & Disk drive are the hardware attached inside the CPU box.
Printer and Monitor are the examples of output devices.
Yes, mouse and keyboard can be wireless.

A disk drive is an internal hardware component of the computer system that is used to
read and write on storage disks.

CD- RW stands for Compact Disk Rewritable.

Skylake is Intel’s multi-core chips code which boots graphics and applications while
improving battery and life in laptops.

. The differences between Input and Output Devices are as follows:

Input Devices Output Devices

a.Input devices are devices through a. Output devices are devices through which
which a computer accepts data and  a computer displays the information and
instructions result of computation to the user.

b. Example of the input devices are: b. Example of the output devices are: Monitor,
Mouse, Keyboard Printer

The Central Processing Unit (CPU) is a processor and sometimes called a microprocessor. It
is the computer’s brain as it performs all the calculations and runs programs, managing
operations and executing the basic instructions that control the computer.

Virtual keyboard is operated by typing on a touch-sensitive surface rather than pressing
physical keys. It is essentially a software component, as it does not consist of physical parts.
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4. Aportisaslot on the motherboard that is used to connect other components of the computer
such as keyboard, mouse, monitor, etc. to the motherboard. Three types of ports are:

1. Serial Port
2. Universal Serial Bus (USB) Port
3. Parallel Port

5. Switched Mode Power Supply (SMPS) is a hardware component of the computer used to
control the power supply. It is also known as the power supply unit of the computer. It takes
the Alternating Current (AC) from a source and converts it into low voltage Direct Current
(DC) and then supply to other parts of the computer system. It has a switching regulator
to control the output voltage and an in-built fan to reduce heat.

C. 1. Akhil can use a graphic tablet to draw directly on the computer screen. It comes with a
stylus that allows him to sketch and create digital artwork with precision.

2. Divya should buy a plotter. Plotters are specialised printers that produce high-quality
drawings and are suitable for printing architectural and construction plans.
Higher Order Thinking Skills (HOTS)

1. The best hardware device for Samira would be a card reader. It helps in transferring photos
easily from the camera’s memory card to the computer.

2. Vaidik should use a projector to display the presentation on a big screen and speakers to
ensure that the audience can hear clearly. This will help him deliver an effective presentation.
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n Number System

One A Touch Learn )

A. 1 c
B. 1T
C. 10
5 8
Let's Do It
A. 1
2.
3
B. 1
2.
Step 1
Step 2
Step 3
Step 4
Step 5
3.

2. a.
2. T
2. 2
6.

N

Binary

3. ¢ 4. a.
3. T 4. T
3. Decimal number

. Octal number system consists of eight digits from 0 to 7.
In 1 nibble there are 4 bits.

5T
4. 10

. The total number of digits used in a number system is called its base or radix.

. A number system is a method of counting. Computers use the Binary Number System to

represent data like text, audio, and video. The number of digits in a system is called its base
or radix. There are four types of number systems:

(i) Decimal number system
(i) Binary number system

(iii) Octal number system

(iv) Hexadecimal number system
To convert a decimal number into a binary number:

Divide the decimal number by 2 (the base of the binary number system).

Note down the quotient and the remainder.

Divide the quotient obtained again by 2 and note down the resulting quotient
and remainder.

Repeat the procedure till you reach a quotient less than 2.

Arrange the final quotient and all remainders in reverse order (from bottom to
top) to get the binary number.

The rules to subtract two binary numbers are:

X|Y X-Y

0| O 0-0=0

ol 1 0-1=1
(borrow 1, so that 10-1 = 1)

0 1-0=1

1 1-1=0

DI2OIIPP000 0

Trackpad iPRO (Ver. 4.1)-VII (Answer Key) | 3



1. (10111.011), = 1 x22+0x 22 +1x 22+ 1x2'+1x20+0x 2 +1x22+1x23

= 1x16+0+1x4+1x2+1x1+0+1/4+1/8
= 16+4+2+1+025+0.125
= (23.375),,

=

. @ 0D @
1 0 0 1 1 0
- 1 1 0 1
1 1 0 0 1
3. (@) 1 0 0 0 (b) 1@ Q) —cany
* 1 01 1 0 1 1
1 1 + 1 0 1
1 0 0 0 O
(© @ —— Carry (d) @ @ @ —— Carry
1 0 1 1 1 1 1
+ 1 0 1 £ 01 1 1 1
1 1 1 0 11 1 1 0
@ — Carry
() 1 1 0 0 1
+ 1 0 1 O
10 1 1 0
4. (a) 2 39 b)) 2 72 (@) 2_ 128
2 [ 19-1 2[36-0 2| 64-0
2| 9-1 2[18-0 2| 32-0
2 4-1 2| 9-0 2| 16-0
ST 20 2| a1 2] 8-
| 1-0 2| 2-0 2| 4-0
1 120 2 2-0
Hence, (39),, = (100111), —] 1-0
Hence, (72),,
= (1001000), Hence, (128),,
= (10000000),
)
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d 255 (e) 2 | 173
2| 27-1 2| 86-1
2 [13-1 2] 43-0
2] 6-1 2| 21-1
2| 3-0 2| 10-12
] 1-t 2| s5-0

Hence, (55),, = (110111), 2| 2-1
1-0
Hence, (173),, = (10101101),
D. 1 2] 155

2| 7-1

2| 38-1

2] 19-0

2| 9-1

2 4-1

2| 2-o0

] 1-o0

2. There are only four commonly used number systems in computing:
- Binary (Base 2): Uses digits 0 and 1

« Octal (Base 8): Uses digits 0 to 7
« Decimal (Base 10): Uses digits 0 to 9
« Hexadecimal (Base 16): Uses digits 0 to 9 and Ato F

Higher Order Thinking Skills (HOTS)

1. 1x2*=16

0x2°=0

1x2°=4

1x2t=2

1x2°=1

Total =16 +0+4 +2+1=23
2. 1x2°=32

0x2*=0

1x2°=8

1x22=4

1x2t=2

0x2°=0

Total=32+0+8+4+2+0="%*46
£l
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Lets Do It

A. 1. Trojan horse is a type of malware. It conceals itself inside the software that seems
legitimate.

2. The use of antivirus program is to identify prevent, and remove malware from the computer
system.

3. Boot sector virus is one of the most destructive types of computer viruses that infects the
boot sector or the master boot record (MBR) of hard disks and floppy disks.

4. MBR stands for Master Boot Record.

B. 1. Amalwareisatype of malicious program designed to damage or carry out other unwanted
actions on a computer system. Malware can affect the computer in the similar way a virus
do. Some of the common malwares are worm, Trojan horse, spyware, ransomware, rootkit
and backdoor.

2. A computer virus is a piece of code or program developed to corrupt the data or program
files stored on the computer system. A computer worm is a type of malware that can
replicate itself without any human interaction.

3. An infected computer system will:
(i) Slowdown: A noticeable decrease in the computer’s processing speed.
(i) Pop-ups: Unexpected or excessive pop-ups appearing on the system.
(iii) Crash: Frequent system crashes or Blue Screen of Death (BSOD) errors.
(iv) Loss of Files: Abrupt or unexplained deletion of files.

(v) Unusual Activity of Messages or Programs: Automatic opening or closing of programs,
unexpected restarts, and strange or unknown windows appearing during boot-up.

4. Ways to prevent a virus are:
(i) Download only legal software.
(i) Don't open any unknown e-mail
(iii) Don’t open any e-mail attachment from unknown sources.
(iv) Don't download music, program or games from unknown sources on the Internet.
(v) Install an antivirus program in your computer system.

C. 1. Yes, this could be avirus infection, possibly introduced through the USB drive. Some viruses
can hide, delete, or alter files on a computer. Steps Neha should take:

(i) Immediately disconnect the USB drive to prevent further spread.
(i) Run a full system scan using updated antivirus software.

(iii) Use data recovery tools if important files were deleted.

(iv) Do not open unknown files or programs created automatically.

2. Yes, thisis most likely a ransomware attack, where files are encrypted and access is blocked
until payment is made.

8.0
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Actions Anil should take:

(i) Do not pay the ransom, as it does not guarantee recovery.

(i) Disconnect the computer from the Internet to prevent further damage.
(iii) Use a reliable antivirus or anti-ransomware tool to remove the malware.
(iv) Try to restore files from a backup.

Higher Order Thinking Skills (HOTS)

1. Yes, it could be due to a virus. Viruses can corrupt system files, consume memory, and slow
down startup.

Examples: File-infecting virus, Boot sector virus, Worms.
2. This may be due to malware like spyware or adware. Steps to safeguard the system:
(i) Run a full system scan using updated antivirus or anti-malware software.
(i) Uninstall unknown or suspicious programs.
(iii) Clear browser cache and disable unknown extensions.
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nEthics and Safety Measures in Computing

One A Touch Learn o)

A. 1 a 2. ¢ 3. ¢ 4. b. 5 a
B. 1T 2. F 3. F 4. T 5 F
C. 1. Trademark 2. Plagiarism 3. Patent 4. Phishing 5. Spam
o
lets Do It
A. 1. Software piracy means illegal use of software.
2. Hacking is the unauthorised access to computer system for the purpose of destroying the
system or stealing important information from the system.
3. Patents and Copyright are the two examples of intellectual property rights.
4. Computer Ethics are the common guidelines that we need to follow while using the computer.
5. Two ways to stop Cyberbullying are:
(i) Don'tdisclose your personal information like address, phone number and school name
online with unknown people.
(i) Be careful about sharing private information with others online as this could be shared
with or seen by people with malicious intent.
B. 1. Patent is the right that gives an inventor the complete right to make, use, and sell
his or her work for a specific time period.
On other hand, Trademark is a symbol or word legally registered or established used as
representing a company or product.
2. Internet is Network of Networks, means International Network.
Two disadvantages of Internet:
(i) Wastage of Time: It is a wastage of time as with the excessive use of the Internet
people get addicted to it and spend lots of time on surfing.
(i) Virus and Spam Attacks: Internet has also increased the cases of virus attacks. Users
can lost their data and programs in these virus attacks.
3. Three protective measures to avoid Plagiarism:
(i) We should always mention the source of information.
(i) We should rephrase the content as per our requirement to avoid Plagiarism.
(iii) We should use quotation marks to write the word or lines written by someone else.
4. Three ways to stay protective online:

(i) Be cautious while using your password online.
(i) Don't entertain strangers or suspicious mails.
(iii) Don't share your personal details with anyone online.
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C. 1. Checksender, spelling errors, and avoid clicking unknown links. It could be spam or phishing.
2. Rajiv should check for https in the URL and a padlock icon in the address bar to ensure the

site is secure.
Higher Order Thinking Skills (HOTS)
1. No, sharing personal details can lead to identity theft and misuse. It is risky and unsafe.

2. It means apps may be tracking activity. This can affect privacy and lead to targeted ads and
data misuse.
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nSpreadsheets—An Introduction
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A. 1 c 2. ¢ 3. a 4. d. 5. a. 6. d.
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B. 1.
C. L
4.

F 2. T 3. F 4, F 5 F
Name box 2. Title 3. Quick Access
Formula 5. Worksheet

@

Lets Do It )

A. 1.

Excel is the most commonly used interactive spreadsheet program that allows us to perform
mathematical calculations, analyse data, and store data in tabular format. We can create
charts and graphs from the data and convey more meaningful information.

Ribbon is like a strip that has various tabs such as Home, Insert, Page, Layout, Formulas
and Data.

The currently selected cell that appears highlighted with a green border is an active cell.

Name box is a box located in the left side of the excel window, just below the Ribbon. The
address of the active cell is displayed in the box.

Formula bar is a text box located on the right side of the Name Box that allows you to
enter and edit formulas and perform calculations on your worksheet data. It is also used
for entering and editing the contents.

The row heading is the gray coloured number (1,2,3...etc) located in front of each row in
the worksheet.

A worksheet is a main working area in excel window where we can enter data. A workbook
is a collection of different worksheets.

To create a new workbook in Excel 2019, follow these steps:
Step 1 Click on File tab.

Step 2 Click on the New option.

Step 3 Click on blank workbook.

A new workbook will be created.
Excel supports different data types like numbers, text, and dates. Numbers are aligned right,

and dates are also aligned right but follow a date format (like 12/04/2025). Ravi can use

the Number Format option on the Home tab to correctly format the cells as either Number
or Date.

Column headers (A, B, C, etc.) cannot be changed. Jasleen might have tried to rename a
column, but only cell content can be edited, not column letters.

Higher Order Thinking Skills (HOTS)

a.
b.

Component S represents the active cell.

Click on Component P (the File tab). Then click on Save or Save As, choose the location,
enter the file name, and click Save.

Click inside Component S (the active cell), type the data using the keyboard, and press
Enter to confirm.

Component V is the Status Bar.
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nMore on Spreadsheets

One Touch Learn )

A.
B.
C.

1
1
L

d. 2. a 3. a 4. c 5. b. 6. a.
Insert 2. Cell styles 3. Selectall 4. Merge & center
F 2. T 3. F 4. T 5T
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A.

1.

Yes, we can unmerge the merged cells. The command which is used to unmerge the cells
is Unmerge cells command.

Copy command is used to copy the contents of one cell to other cells.

Wrap text feature of MS Excel allows user to display multiple lines of text inside a cell.
To create a custom number format, follow the given steps:

Step 1 Click on the cell(s) that contain(s) the numbers that you want to format.

Step 2 Click on the arrow next to the Number Format box.

Step 3 Click on the More Number Formats option to see more details of number formats.
Step 4 Select the Number category.

Step 5 Click on the OK button.

Steps to change row height and column width are:

Step 1 Select the column(s) or row(s) whose width or height you want to change.
Step 2 Click on the Format command.

Step 3 Click on Column Width or Row Height.

Step 4 Type the desired value in the Column Width or Row Height box.

Step 5 Click on OK button.

Steps to apply cell border are:

Step 1 Select the cell or cell range where you want to add or change a border.

R



Step 2 Click on the Home tab.

Step 3 Click the arrow next to Borders command.

Step 4 Click on the border style you would like.

The elements of a formula are:

References: A cell or a range of cells that you want to use in your calculation.

Operators: Symbols (+, -, *, /, *, $, %, etc.) that specify the calculations to be performed.

Constants: Numbers or text values that do not change.

5. When performing calculations using a formula, Excel follows certain rules of precedence:

i. Excel calculates expressions within parentheses (', /)" first.

ii. Excel calculates multiplication and division before addition and subtraction.

iii. Excel calculates consecutive operators with the same level of precedence from left to right.

visible in the cell.

. Sonia can use the Wrap Text feature or increase the column width to make all the text

2. Anaya can use the Insert command to add a new column or row in the marksheet to enter

the missing marks.

Higher Order Thinking Skills (HOTS)
1. Click on the row number “7" on the left side of the Excel sheet to select the entire row.

2. a. Select cells B1 and C1, then click on "Merge & Center” from the Home tab.
b. Use the formula: =E2+F2+G2+H2+I2. Type it in cell J2 and then drag it down to fill for

the other students.

.
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Worksheet-1

(Based on chapters 1 & 6)

1. Digital Versatile Disc (DVD) Blu-ray Disc (BD)
2. Audio PS/2
3. Octal Binary
4. Jerusalem Cascade
5. Cyber bullying Plagiarism
6. Title Bar Ribbon
1. All the physical components of a computer system are called Hardware.
2. The total number of digits used in a number system is called its base or radix.
3. A set of programs that identify and remove malware are known as antivirus software.
4. Cyber crime can be defined as criminal activities carried out by means of computers or the
Internet.
5. Acell range is a collection of two or more cells.
6. AutoFill feature automatically fills a series of data in our worksheet.
1. CPU 2. SMPS 3. Webcam 4. Binary Number (Byte)
5. Malware 6. Digital Footprint 7. Title Bar 8. equal (=) sign
1. Projector 2. Graphic Tablet 3. SMPS
Test Sheet-1
(Based on chapters 1 to 6)

Section A
1 a 2. a 3. ¢ 4. b. 5. a.
6. d. 7. ¢ 8. a
1. input devices 2. 8 3. Antivirus
4. Spam 5. Formula 6. Cell styles
1. F 2. T 3. F 4. T 5 F 6. F

Section B
1. Yes, mouse and keyboard can be wireless.
2. There are 4 bits in 1 nibble.
3. Eradicating a virus is the term used for cleaning a computer.
4. Cyberbullying is the use of electronic media such as smartphones, computers and tablets

to harass or attack a person. It is also known as online bullying.
5. The currently selected cell that appears highlighted with dark black border is an active cell.

fiol
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6. Yes, we can unmerge the merged cells. The command which is used to unmerge the
cells is Unmerge cells command.

B. 1. Switched Mode Power Supply (SMPS) is a hardware component of the computer used to
control the power supply. It is also known as the power supply unit of the computer. It
takes the Alternating Current (AC) from a source and converts it into low voltage Direct
Current (DC) and then supply to other parts of the computer system.

20 =1x22+1x22+1x20+1x2°
=8+4+2+1
=15

(1111),= (15),,

3. Acomputervirus is a ‘piece of code’ or program developed to corrupt the data or program
files stored on the computer system. Two types of computer virus are Jerusalem and Cascade.

4. Plagiarism is simply taking other person’s work, and instead of giving credit to the person
who actually prepared that, presenting it as your own work. Two ways to prevent Plagiarism:

(i) We should always mention the source of information.
(i) We should use quotation marks to write the word or lines written by someone else.

5. A worksheet is a main working area in excel window where we can enter data. A workbook
is a collection of different worksheets.

6. Steps to change row height and column width are:
Step 1 Select the column(s) or row(s) whose width or height you want to change.
Step 2 Click on the Format command.
Step 3 Click on Column Width or Row Height.
Step 4 Type the desired value in the Column Width or Row Height box.
Step 5 Click on OK button.

Database and DBMS—An Introduction

One Touch Learn )

A. 1 d 2. a 3. b 4. c 5. d.
B. 1. Form 2. fields 3. primary 4. Sorting 5. Navigation
cC 1T 2. F 3. F 4. F

@

Lets Do It @

A. 1. Primary Key is a unique field by which the records are uniquely identified in a table.

2. The final result of the manipulated data that comes from tables or queries in DBMS is
known as a report.

) 200000 Taciond PRO e 4111 (rswr ko) 15



3. A query is the most powerful object of database. It helps us to retrieve information from
a table based on some criteria or condition.

4. A form is a database object used to create a user interface to enter or update a record in
a table that is connected to it.

B. 1. Stepsto add record in Database are:
Step 1 Double-click to open table in Datasheet view.
Step 2 Click on the field to add the new record.
2. Four data types of Access are:
1. Text 2. Currency 3. Number 4. AutoNumber
C. 1. Advantages of the Database Management System are:
(i) It minimises the duplication of data by integrating and sharing the data files.
(i) It saves the storage space.
(iiif) All the users are provided with some access rights or privileges and permissions.
(iv) The files can be easily updated whenever any changes are being made.

2. There are two types of views in Access:

(i) Design View: In the Design view, the records are not visible. You can only see the field
names along with their data types. You can add or delete a field name.

(i) Datasheet view: Datasheet view is the default view of the table. It shows all the fields
and the records as entered by the user. In this view, you can edit the content of the
table.

3. Following are the rules we should remember while writing field names:

(i) Field name can be up to 64 characters long.

(i) Field name can include any combination of letters, numbers, spaces, and special
characters except a period (.), an exclamation mark (!), an accent grave (') and brackets
([D.

(iii) Field name cannot begin with the leading spaces.

(iv) Field name cannot include a double quotation mark (”).

D. 1. Sorting: Ranjeet can use the Sort feature in Access to view records in ascending or
descending order.

2. Relational Database: Jennifer is most likely using a relational database. An example is
Microsoft Access.

Higher Order Thinking Skills (HOTS)

1. Query: A Query should be used to retrieve records of students who scored above 90%.

2. Datasheet View: Student information should be typed in the Datasheet View of the Access
table.

fiol
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nMore on Access

One A Touch Learn &)

A 1. b 2. b 3. ¢ 4. c

B. 1 F 2. F 3.7 4. T 5T

C. 1. Title logo 2. Layoutview 3. Relationship 4. Run 5. Foreign key.
D. 1 c 2. a 3. d. 4. b.

CR
Lets Do It ‘

A. 1. Aformisadatabase object used to add, edit and display data from a table in a user-friendly
manner.

2. The two types of queries in Access are:
i. Select Query
ii. Parameter Query

f)
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3. The three main views in which a form can be displayed are: Form view, Design view and
Layout view.

B. 1. Aqueryisthe mostimportant object provided by Access that can give us information that
we might not be able to find by looking at the table directly. A report in Access is a feature
which allows us to organize and present our data in a user-friendly format so that it can
be printed.

2. To create a report, follow these steps:
Step1 Click on the Create tab.
Step 2 Open the desired table for which you want to create a report.
Step 3 Click on the Report command.
The report of the table, which is open, will be created.
3. Four parameters of the design grid in the bottom part of the Query window are:

i. Field: It is the first row of the design grid that displays the selected field names from
the table.

ii. Table: It displays the names of the existing tables in the relationship window.
iii. Sort: It displays the data in either descending or ascending order during the run time.

iv. Show: This means that the field with the checkmark will be displayed in the result, and
the fields with an uncheck mark will not be displayed when the query runs.

C. 1. Neil should use the Design tab and click on the Logo and Title commands in the Header/
Footer group to add those elements to his form.

2. The corresponding field in the Orders table should be named CustomerID. This is because
it will act as a foreign key that links to the primary key in the Customers table, establishing
a relationship between the two tables.

Higher Order Thinking Skills (HOTS)

1. The default view in which a form appears when first created in Microsoft Access is the Form
View.

2. A Multiple Items Form allows viewing multiple book records at the same time, which helps
in identifying overdue books easily.
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2.

<OLTYPE = "a">

We use the <UL> tag to create an unordered list in HTML. It displays a list of items with
bullets (such as disc, circle, or square) instead of numbers or letters.

The border-spacing property is used to specify the space between the borders of adjacent

cells.

Syntax:
table
{
border-spacing: value;

}

<style>
table
{
border: 3px solid red;
border-spacing: 10px;
}
td {
padding: 15px;
}
</style>
<table>
<tr>
<td>Cell 1</td>
<td>Cell 2</td>
</tr>
</table>

The ROWSPAN attribute applies when a cell is extended for more than one row, that is,
the cell spans for 2 or more rows instead of 1 as shown in below table.

Example for using ROWSPAN attribute is:

<TD ROWSPAN="3">

Category Types
Badminton
Football
Sports
Basketball
Judo
Martial Arts Karate

zg Trackpad iPRO (Ver. 4.1)-VIl (Answer Key)
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Here, the cell "Sports” is taking a span of 3 rows and "Martial Arts” is taking a span of 2
rows.

C. 1. Nishashould use the rowspan attribute to merge table cells vertically across multiple rows.
2. Rakesh should use the background-color CSS property to change the background colour
of the table.
3. Use the background-image CSS property to set an image as the table background.
You can set the height and width using CSS either in a <style> section or inline.

Higher Order Thinking Skills (HOTS)

1. (i) The <UL> tag is opened and closed repeatedly for each <LI> item — it should be
opened once before all list items and closed once after all.

(i) The <LI> tags are not closed properly — they should have a corresponding </LI>
closing tag (optional in some browsers but recommended for clarity and correctness).

2. a. <!DOCTYPE html>
<html>
<head>
<title>Planets List</title>
</head>
<body>
<hl>Planets in Our Solar System</hl>
<ol type="A">
<li><b>Mercury</b> - The smallest planet and closest to the Sun.</1li>

<1i><b>Venus</b> - Known for its thick atmosphere and extreme
temperatures.</1li>

<li><b>Earth</b> - The only planet known to support life.</1li>

<li><b>Mars</b> - The Red Planet, famous for its iron oxide
surface.</1li>

<li><b>Jupiter</b> - The largest planet, known for its Great Red
Spot.</1li>

<li><b>Saturn</b> - Known for its magnificent ring system.</li>
<li><b>Uranus</b> - A blue planet that rotates on its side.</li>

<li><b>Neptune</b> - The farthest planet from the Sun, known for
its strong winds.</1li>

</ol>
</body>
</html>

b. To change the numbering from A, B, C...to 1, 2, 3..,, replace type="A" with type="1" in the
<ol> tag. This will display the list items with numbers instead of capital letters.
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A. 1. Altattribute specifies the alternate text to be displayed in the web browser, if the provided
image is not found.
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<audio src="TalkNext.mp3" controls> </audio>

3. Radio buttons and checkboxes both take user input in forms. The difference is that radio
buttons allow only one selection, while checkboxes allow multiple selections.

4. Five different values that can be assigned to the type attribute of the <input> tag are: text,
password, checkbox, radio, and submit.

B. 1. We use framesin HTML to display more than one web page on a single screen of the web
browser. These multiple web pages are shown in different sections called frames. HTML
provides the <IFRAME> tag, which stands for Inline Frame, to embed another HTML
document within the current web page.

2. The controls attribute is used with the <video> element to display built-in playback
controls—such as play, pause, volume, and fullscreen options—directly in the video player.
When the controls attribute is present, users have a simple, interactive interface for managing
video playback without needing additional scripts or plugins.

3. You can open a link in a new browser window or tab by using the target attribute with a
value of _blank in the <a> (anchor) tag.

4. (i) Usethe <input> tag with the attribute type="checkbox" to create the check box control.
(i) Assign a unique value attribute to each check box to represent the option it stands for.
(iii) Optionally, use a <label> tag to provide a descriptive text for the check box.

C. 1. Youcan use internal links (<a href="#section">) to navigate within a course, and external
links (<a href="https://example.com" target="_blank">) to connect to outside resources.
2. Use the <iframe> tag to display two web pages side by side. One page can include a list
and radio buttons, while the other can show checkboxes. This allows users to view and
interact with both pages on a single screen.
Web Page 1 - Using a List with Radio Buttons:
<!DOCTYPE html>
<html>
<head>
<title>Course Options - Radio Buttons</title>
</head>
<body>
<hl>Select Your Preferred Course Type</hl>
<ol>
<li>
<input type="radio" name="course" value="online" id="online">
<label for="online">Online Course</label>
</1li>
<li>
<input type="radio" name="course" value="offline"
id="offline">
<label for="offline">0ffline Course</label>
</1i>
<li>
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<input type="radio" name="course" value="hybrid" id="hybrid">
<label for="hybrid">Hybrid Course</label>
</1li>
</ol>
</body>
</html>
Web Page 2 - Using a List with Checkboxes:
<!DOCTYPE html>
<html>
<head>
<title>Resources - Checkboxes</title>
</head>
<body>
<hl>Select the Resources You Need</hl>
<ul>
<li>
<input type="checkbox" name="resources" value="ebooks"
id="ebooks">
<label for="ebooks">E-books</label>
</1li>
<li>
<input type="checkbox" name="resources" value="tutorials"
id="tutorials">
<label for="tutorials">Tutorials</label>
</1li>
<li>
<input type="checkbox" name="resources" value="webinars"
id="webinars">
<label for="webinars">Webinars</label>
</1li>
</ul>
</body>
</html>

Higher Order Thinking Skills (HOTS)

1. <!DOCTYPE html>

<html>

<head>

<title>NEWS</title>

</head>

<body>
<hl>School News Bulletin</hl>
<marquee direction="right">

5
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* Dance competition will be held on Monday.

</marquee>

<marquee direction="right">

* You have to submit your entries for the school magazine by Friday.
</marquee>
</body>
</html>

2. (i) BREADTH is not a valid attribute. It should be WIDTH.

(i) ALIGNMENT is incorrect. It should be align.
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Worksheet-2

(Based on chapters 7 to 10)
A. 1. A collection of programs required to store and retrieve data from a database is called
Database Management System (DBMS).

2. Datasheet view is the default view of the table. It shows all the fields and the records as
entered by the user.
3. Query allows user to retrieve information from a table based on some criteria or condition.
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4. A form is a collection of different types of fields to take the input from the user on a web
page.

5. This type of list is used to display the items in a sequential manner. <OL> tag is used to
create an ordered list.

6. Interlinking refers to connecting one web page to another using hyperlinks. It helps users
navigate between related sections or pages of a website.

Microsoft Access ORACLE
Title Bar Ribbon
Text Memo
Select Parameter
Type Start
Control Autoplay
Field Properties Pane

Design

Date/Time

Report

Ordered List

<TR>

BG COLOR

ALINK

TYPE

<TEXTAREA>

<INPUT TYPE="RADIO" >

<INPUT TYPE="BUTTON">
<SELECT>
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Test Sheet-2

(Based on chapters 7 to 10)

Section A
C. 3. a. 4. c. 5. b. 6. a.

C.

T 3. T 4. F 5 F 6. T

Form Relationship

run ordered list
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M
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<a> <select>
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Section B
A. 1. Primary key is a unique field by which the records are uniquely identified in a table.
Yes, we can add an image as a background in a form of Access. It can be done using the
Design tab.
3. <CAPTION> tag is used for defining the title of the table.
BORDER specifies the thickness of the border surrounding the image.
B. 1. Advantages of Database system are:
(i) It minimizes the duplication of data by integrating and sharing the data files.
(i) It saves the storage space
(iii) All the users are provided with some access rights or privileges and permissions.
(iv) The file can be easily updated whenever any changes are being made.

2. Aformis a database object used to create, edit and display data stored in tables in a user-
friendly manner. Three main views in which a form can be displayed are:

(i) Form View
(i) Design View
(i) Layout View

3. <html>
<head>
</head>
<body>
<table border="1">
<tr>
<th rowspan="2"> Name</th>
<th rowspan="2"> Subject</th>
<th colspan="2"> Marks</th>
</tr>
<tr>
<th>Term 1</th>
<th>Term 2</th>
</tr>
<tr>
<td>Chirag</td>
<td>English</td>
<td>79</td>
<td>87</td>
</tr>
<tr>
<td>Divya</td>
<td>Math</td>
<td>88</td>

DI oot



<td>83</td>
</tr>
</table>
</body>
</html>
4. The two attributes of <INPUT> tag are as follows:
i. TYPE: This attribute is used to specify the type of field we want to create. It takes one of
the predefined values.
ii. NAME: This attribute is used to specify the identity of the field on the web page.
<INPUT TYPE="VALUE" NAME="VALUE" VALUE "ABC">

Let us create a web page containing a login form to accept the user name and password
from the user. The code to create the Form.html is as follows:

<!DOCTYPE html>
<html>
<head>
<title>Login Form</title>
</head>
<body bgcolor="lightyellow">
<form>
User Name: <input type="text" name="username"><br>
Password: <input type="password" name="password"><br>
<input type="checkbox"> Remember me next time<br>
<input type="submit" value="Log In">
</form>
</body>
</html>
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